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Grande Internet Quick Guide
Congratulations! You are now connected to the Internet through Grande’s Internet service.  
Your Internet service will provide you with an online learning experience that’s also fun, 
unlimited access to a wealth of educational resources, music channels to suit the tastes of 
every family member, local weather and international news videos - all this and more is now 
available through your computer.

Grande’s Internet Quick Guide will provide you with basic information on setting up indi-
vidual Internet service like email, webmail, our web portal, web premiums and much more.

The latest version of the Grande Internet Quick Guide can be accessed online at
http://www.grandecom.net/support under User Guides.

Grande Privacy Policy and Appropriate Use Policy
Our Privacy Policy discloses Grande’s information gathering and dissemination practices for 
the websites operated by Grande Communications.

Our Appropriate Use Policy is designed to help protect our customers and the Internet 
community from irresponsible or illegal activities. This document constitutes a binding legal 
contract between you and Grande Communications.

Please make sure that you have read and agreed to these document’s terms before continue 
using our services. The Grande Privacy Policy and Appropriate Use Policy are located on 
the footer of our corporate website:
http://www.grandecom.com

Connecting a Cable Modem
1. Connect the coaxial cable that is dedicated to your cable modem to the cable connector 
    on the back of the cable modem.
2. Plug one end of the Ethernet cable into the Ethernet port of the Ethernet card on your 
    computer.  Please note that if you have a computer with both USB and Ethernet
    connectors, only use one or the other, not both.
3. Connect the other end of the cable to the Ethernet jack on the back of the cable modem.
4. Once the Ethernet cable has been connected to the cable modem, connect the power 
    cord into the modem’s power connector.



5. Connect your computer’s power cord into your power outlet.
6. If your modem has a power switch, turn it on. Wait while the modem synchronizes. A 
    light on your modem will activate once completed.

Note: If you are connecting using a USB cable, the USB driver for the cable modem must be installed 

for the computer to recognize the Internet properly.

Troubleshooting your Cable Modem
Power-cycle the Cable Modem
Sometimes it is necessary to shut down your cable modem connection completely when 
something isn’t functioning properly. This is similar to rebooting your computer. To power-
cycle your cable modem and restore connectivity, follow the directions below.

1. Make sure the coaxial cable is plugged securely into the modem and the wall outlet (a 
    loose connection could result in lost or slow connectivity)
2. Unplug the cable modem from the power source
3. Leave the modem unplugged for two minutes
4. Plug the cable modem directly into the wall outlet
5. Wait up to approximately five minutes for the modem to regain sync (it usually takes less 
    than two minutes and for many people, it takes less than one minute to gain sync)
6. Check the lights on your modem to ensure the cable lights are steady
7. If the lights are illuminated, try visiting various Web sites
8. If you are unable to connect to Web sites, continue to the next step
9. Properly shut down the computer and turn off the power by pushing the on/off button on 
    the computer
10. Restore the power and turn on the computer
11. Try several addresses on the Web

Note: If you have Grande Cable Service, check to see that you are receiving cable programming and 

that you have a clear picture. If you are not receiving your Grande cable programming, your data 

service will not function. Call and report your difficulty to your local Grande Customer Care Center.
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Connecting a DSL Modem
1. Connect a phone line to your DSL modem to the LINE connector on the back of the
    DSL modem.
2. Plug one end of the Ethernet cable into the Ethernet port of the Ethernet card on your 
    computer. Please note that if you have a computer with both USB and Ethernet
    connectors, only use one or the other, not both.
3. Connect the other end of the cable to the Ethernet jack on the back of the DSL modem.
4. Once the Ethernet cable has been connected to the DSL modem, connect the power cord 
    into the modem’s power connector.
5. Connect your computer’s power cord into your power outlet.
6. If your modem has a power switch, turn it on. Wait while the modem synchronizes. A 
    light on your modem will activate once completed.

Note: If you are connecting using a USB cable, the USB driver for the cable modem must be installed 

for the computer to recognize the Internet properly.

Troubleshooting your DSL Modem
Power-cycle the DSL Modem
Sometimes it is necessary to shut down your DSL modem connection completely when
something isn’t functioning properly. This is similar to rebooting your computer. To power-cycle 
your DSL modem and restore connectivity, follow the directions below.

1. Make sure the telephone cable is plugged securely into the modem and the wall outlet (a 
    loose connection could result in lost or slow connectivity)
2. Unplug the DSL modem from the power source
3. Leave the modem unplugged for two minutes
4. Plug the DSL modem directly into the wall outlet
5. Wait up to approximately five minutes for the modem to regain sync (it usually takes less 
    than two minutes and for many people, it takes less than one minute to gain sync)
6. Check the lights on your modem to ensure the DSL lights are steady
7. If the lights are illuminated, try visiting various Web sites
8. If you are unable to connect to Web sites, continue to the next step
9. Properly shut down the computer and turn off the power by pushing the on/off button on 
    the computer
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10. Restore the power and turn on the computer
11. Try several addresses on the Web
Note: If you have Grande Phone Service, check to see that you have a dial tone.  If there is no dial tone, 

contact and report your difficulty to your local Grande Customer Care Center.

Connecting to the Internet with a Fiber To The Home service
Grande’s Fiber To The Home service does not require any special type of modem to work.  
You can just plug one end of the Ethernet cable into the Ethernet port of the Ethernet card on 
your computer and the other end into the wall Ethernet outlet. Your computer will automatically 
start searching for an IP address. Once it gets an IP address, you should be able to access 
the Internet.

Troubleshooting your FTTH service:
• Verify that the Ethernet cable is plugged in correctly on both ends
• Verify your other Grande services (Phone or Cable TV) are working properly
• Make sure Uninterruptible Power Supply (UPS) is plugged in (this will have an APC label).  
   The UPS is a battery and must be plugged in to provide telephone service in the event
   of a power failure.
• If you have checked all connections and the UPS to make sure it is plugged in, call and 
   report your difficulty to your local Grande Customer Care Center.

Grande Webmail
Grande’s Internet service comes with up to 5 email accounts each with 100MB of email stor-
age. Once your initial account has been set up by Grande Customer Care Representatives 
you can begin sending and receiving emails from family and friends. If you are on the road 
away from your computer or you rather not use an email application you can always access 
your email through a web browser from anywhere in the world using Grande’s Webmail 
service.
To access your email using Grande’s Webmail you will need:
   • Your Grande username and password
   • Access to a web browser (i.e. Microsoft Internet Explorer, Apple Safari, Mozilla Firefox)
The most common ways to get Grande’s Webmail service are:
   • Entering the following URL directly on a web browser: http://webmail.grandecom.net
   • Clicking on the “Check E-mail” link on GrandeCom.net Web Portal
Note: For additional privacy accessing and viewing your email online, you can use our Secure Webmail 

service. Just add an “s” on the Webmail URL https://webmail.grandecom.net and this will initiate the 

Webmail service over a secure connection.
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Logging in
1. Go to http://webmail.grandecom.net
2. Under username, type the Grande username you were assigned*
3. Under password, type the password that you chose (you may change your password
    after you have logged in)
4. If you prefer a language other than English, click on the down arrow and select your
    desired language
5. Click on the Login button
* If you do not remember your username or password, please contact your local Grande 
Customer Care Center.

How to receive email
After you have successfully logged in to your email account, the email system will automati-
cally check for new messages. If you are expecting an email and suspect that it may have 
been sent after you logged in, click on Check Email located on the bottom right, and the 
system will check for new messages.

How to send an email
After you have logged in to your Grande email account, you are only five simple steps away 
from sending an email.
1. Click on the Compose button
2. In the “To” box, type the email address of the person you want to send the email to
3. In the “Subject” box, type the subject of the email
4. Type your message
5. After you have checked that the previous steps have been executed, click on the
    “Send Message” button which is in two areas (either one will work)

How to add an attachment
1. Either, type the path and name of the file you want attached to the message, or click the 
    Browse button and select the file to be attached.  The path and name of the file will
    now appear in the Attachment box.
2. Click the “Attach” button. The file name and size will be added to your list of
    attachments. Please note that for large files and/or slower Internet connections, the
    process of uploading and attaching your file to the email may take a while.

5

Internet Quick Guide



How to read your emails
1. Click on the Subject of the desired email. Once you do, that specific email will open.
2. To open a different email, you will have to click the INBOX button. This will take you
    back to the Inbox folder where you can open a different email by clicking on its subject.

How to reply
1. After you have opened an email, locate the “Reply” and “Reply to All” text.
2. If you want to reply to the person who sent you the message, click on the “Reply” text. If
    you want to reply to everybody the original message was sent to, click on the
    “Reply to All” text.
3. Notice that your email already has the email address of the recipient and the subject.
4. Type your message and then click on “Send Message.”

How to delete an email
1. Click on the white checkbox to the left of the desired email that you wish to delete.
    A checkmark will be placed within the box after you click it.  Do this to as many emails
    as you desire to delete.
2. After you have selected the emails you want to delete, click on the “Delete” text.
3. Your emails have now been sent to a “Trash Folder” which can be accessed by clicking
    on the “Folders” icon.
4. In “Maintenance Operations”, which can be accessed through the options icon, you can 
    set up your account to purge your deleted messages after a set time period, so that
    your disk storage quota will not be used up as quickly.

How to create other folders
Many users often create other folders to help organize email. After reading your mail, you 
can put it in a folder organized by theme, date, etc.
1. Click on the checkbox next to the email you want copied or moved to a different folder. 
    After you have clicked it, the box should be marked with a checkmark.
2. Click on the Down arrow next to the “Messages to” text and click on “New Folder.”
3. Click on “Move” or “Copy” depending on whether you want to move the email to a new 
    folder or want another copy of the specific email in a new folder.
4. A box will then appear asking you to name the new folder. Type in your desired name 
    and click OK.
5. To view the folder, click on the down arrow by the “Open” text and click on the name of 
    the new folder.
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How to mark your mail
To help organize your email, Grande allows each user to color-code their mail by type. For 
example, if you feel that a certain message is very important, you can mark it as important. 
There are several options you have in terms of marking your mail such as seen, unseen, 
important, not important, answered, unanswered, deleted, not deleted, draft, and not draft.
1. Click on the email that you want to be marked. After you have clicked it, the box should 
    be marked with a check.
2. Click on the down arrow by the text “Mark as” and click your desired category. The 
    email will now be a different color depending on how you categorized it.

For additional information on Grande Webmail you can use our online support located at 
http://www.grandecom.net/support

Manage your Email Account
Using the Email Administration Interface you will be able to change your password; add or 
delete email accounts; set auto-forwarding options; manage your spam filters; whitelist
(allow) or blacklist (disallow) email addresses and setup auto-responder messages.

To access the Email Administration Interface type https://admin.grandecom.net in your 
browser making sure that you use https instead of the regular http.  Type your Grande
Username and Password in the appropriate text boxes and click Log in.

Changing your password
Follow the steps below to change your email account password.
1. Click the “Change” button under the Password title.
2. Type a new Password in the “New Password” and “Confirm” text boxes.
3. Click Change.
4. The Current Status Bar will change to Password Changed.

Remember: Email passwords are case sensitive

Managing Accounts
Your Grande Internet Service may include up to 5 email accounts. You can use this option to 
view your current accounts; setup new accounts or delete accounts you no longer need.
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View current email accounts
When you enter the “Account Manage” option you will see all your valid email accounts 
with their current disk usage information as well as the first and last name assigned to each 
one of them.

Creating a new email account
To create a new email account, follow these steps:
1. Enter a valid username.  This is the first part of the email address (the one that goes
    before the “@” symbol).  The username must be between 3 and 16 characters and
    can contain only letters, numbers, a period, and underscores.
2. Choose a domain name for your email address.  This is the part of the email address that 
    goes after the “@” symbol.  With Grande you can choose from several domain names
    like “grandetx.net” or “grandetexas.com”.  By default “grandecom.net” will be chosen.
3. Enter a password and confirm the password entered.
4. Enter the first and last name.
5. Click on “Add New Account”.  The new account will be created and will now appear
    on the Email Address list.
Note: You will only be able to create an email account if you have not yet reached your maximum limit.

Delete Email Account
To delete an email account, follow these steps:
1. Click on the “Delete” button next to the Email Address you want to delete
2. Click “OK” on the confirmation message
3. A message saying: “SUCCESS: This account has been deleted” will show under the
   “Attention” area

Reset a Password
To reset an email password, follow these steps:
1. Click on the “Reset Password” button next to the Email Address you want to reset
2. Click “OK” on the confirmation message
3. The following message will appear: “If this username is used for a Dialup, DSL, or
    Webspace account please be aware that the password reset will affect these services.”
4. Click “OK” on the confirmation message
5. The final confirmation appears: “The password for “account” was reset to “hpizns”.
    This password can be used permanently, or “account” can login to this site with the
    password “hpizns” and change it.

8

Internet Quick Guide



Forwarding Your Email
You can temporarily forward all incoming email to any email (i.e., forward your home email 
to the office while at work).
  To forward your incoming email, follow the steps below:
  1. Click the “Manage” button under the Forwards bar.
  2. Type the forwarding email address in the text field.
  3. If you would also like a copy kept in your email account, place a check mark in the
      Local box.
  4. Click the “Add” button under the Submit bar.
  To stop forwarding your email, follow the steps below.
  1. Click the “Manage” button under the Forwards bar.
  2. Delete the forwarding address from the Forward text box.
  3. Click the “Add” button under the Submit bar.

Setting up Email Filters

Email Security Management
Grande enables email filters (email security) by default. You may turn this feature off if it is
critical that no email to you be refused. To disable email security click on “Email Security 
Disabled (I will manage my own email security)”.

Spam-Filter Management
When this option is enabled Grande attempts to determine whether your email is clean of 
spam.

There are four options available:
1. No Content Filtering: turns spam filters off
2. Quarantine to my Webmail JUNK folder: this filter will move spam messages into a
    Junk folder that you can browse whenever you choose.
3. Tag my Subject: Line: this filter will add the words, “**** SPAM” to the subject line of
    any email that is identified as spam
4. Discard the email: if spam is found it will be automatically deleted.
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WhiteList email addresses
With this option you can add email addresses or email domains that you would like to bypass 
the spam filters.
To add addresses to the WhiteList:
1. Click on the “Manage” button under the WhiteList column.
2. Enter the list of email addresses using this format: user@domain.com, @domain.com, 
    user@, or domain.com.  Note: Blank lines and all other invalid entries will
    automatically be removed.
3. Click on “Yes” to enable the WhiteList
4. Click on “Save” to save your changes

BlackList email addresses
With this option you can add email addresses or email domains that you would like to 
block.
To add addresses to the BlackList:
1. Click on the “Manage” button under the BlackList column.
2. Enter the list of email addresses using this format: user@domain.com, @domain.com, 
    user@, or domain.com.  Note: Blank lines and all other invalid entries will
    automatically be removed.
3. Click on “Yes” to enable the BlackList
4. Click on “Save” to save your changes

Setting up an Auto-Responder (Bounce)
This feature allows you to create your own automated response message.
To create a message and activate it:
1. Click on the “Manage” button under the Bouncer column
2. Enter a custom message in the text box
3. Click on “Yes” to enable the BlackList
4. Click on “Save” to save your changes
Once enabled, when a new message is received in your mailbox, the sender will 
automatically receive your custom message.
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Setting Up Email Applications
Setup Outlook Express
To set up Outlook Express with your Grande username and password, follow the steps out-
lined below.
1. Open Outlook Express by double-clicking the Outlook Express icon on your desktop.
2. The first time you start Outlook Express the Internet Connection Wizard will run. Select
    Create a new Internet mail account and click “Next” to continue.
3. On the Your Name screen type in your name as you would like it to appear on your
    outgoing e-mail messages and click “Next” to continue.
4. Type in your email address on the Internet E-mail Address screen. Click “Next” to
    continue.
5. On the E-mail Server Names screen, select POP3 from the drop down list.
6. In the space provided below Incoming mail (POP3, IMAP or HTTP)
    server: enter: mail.grandecom.net
7. Type in mail.grandecom.net as your Outgoing mail (SMTP) server and click
    “Next” to continue.
8. On the Internet Mail Logon screen, type in your Grande user name in the field titled
    Account name.  Your user name is everything leading up to, but not including the
    @grandecom.net part of your e-mail address. For example, if your e-mail address is
    test_account@grandecom.net, you would enter test_account as your Account name.
9. In the Password: field, enter in your Grande assigned password. If you do not wish to
    enter your password every time you check your e-mail, put a check in the box
    labeled Remember password. Click “Next” to continue.
10. Congratulations, you have now set up Outlook Express as your e-mail program.
      Click “Finish” to begin sending and receiving e-mail.

Setup Outlook 2003
To open Outlook 2003 double-click the Microsoft Office Outlook 2003 icon on
your desktop.
1. If the E-mail Accounts wizard doesn’t launch on its own, select Tools from the top menu,
    and E-mail Accounts from the drop-down list.
2. Select “Add” a new e-mail account and click “Next” to continue.
3. On the Server Type screen, select POP3 and then click “Next” to continue.
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4. On the Internet E-mail Settings (POP3) page you will need to fill in your information for
    each of the six fields. For Your Name type in your name, for E-mail Address type in
    your Grande provided e-mail address. In the User Name field type in your Grande
    username (which is the part before @grandecom.net in your e-mail address) and in
    the Password field type in your password. 
    For Incoming mail server (POP3) type in mail.grandecom.net
    For Outgoing mail server (SMTP) type in mail.grandecom.net
    When each of the six fields have been filled, click the “Test Account Settings” button.
5. If anything shows up as Failed, return to the previous window and double-check your
    settings.
6. At this point you have finished setting up Outlook 2003 and need to click the “Finish”
    button. You may now begin to use Outlook 2003 to send and receive e-mail.

Setup Windows Mail
Windows Mail is the default email client that comes standard with Internet Explorer. Follow 
these directions to set up a new account:
1. In Windows Mail, click Tools > Accounts > Mail > Add > E-mail Account. This will start
    a mail wizard configuration screen.
2. Enter your name as you wish it to appear in the Display name field.
3. Enter your Grande e-mail address in the usual “ username@grandecom.net” format in
    the E-mail address field.
4. Set up e-mail servers window settings:
    Select POP in the drop-down list
    Enter mail.grandecom.net in the Incoming Mail Server (POP3) field
    Enter mail.grandecom.net in the Outgoing Mail Server (SMTP) field
5. Click “Next”. Your email is now configured to use any available connection.
6. Enter the Grande username and password. Then click “Next”.
7. You should then see a congratulations message. Now click “Finish”. You should now
    be able to send and receive email using your Grande email address.

Setup Entourage (Mac) Mail
1. When Entourage is launched for the first time, the Entourage Setup Assistant will run.
    On the first screen, enter your First name and Last name in the spaces provided and
    then click the right arrow to continue.
2. On the Home Information screen, enter in your home address information, and then
    click the right arrow to continue.
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3. On the Work Information screen, enter in your work address information, and then
    click the right arrow to continue.
4. On the next Welcome screen, select “I want to start using Entourage without 
    importing anything” and click the right arrow to continue. If you do in fact want to import
    information into Entourage, you are always able to do so later by selecting
    File -> Import from within Entourage.
5. On the Junk Mail Filter screen, decide if you want to enable the Junk Mail Filter and
    then click the right arrow to continue.
6. On the Your Name screen, enter in your name as you would like it to appear in your
    outgoing email messages, and then click the right arrow to continue.
7. On the Your E-mail Address screen, select I already have an e-mail address that I’d
    like to use and then enter your grandecom.net email address in the space provided.
    Once completed, click the right arrow to continue.
8. On the Mail Servers screen, make sure that POP is selected in the My incoming mail
    server is a(n) ___ server drop-down list.
    In the Incoming mail server field, enter mail.grandecom.net
    In the Outgoing mail (SMTP) server field, enter mail.grandecom.net
    Click the right arrow to continue.
9. On the Account ID and Password screen, you will need to enter your username in the
    Account ID field. Your user name is everything leading up to, but not including the
    @grandecom.net part of your email address. For example, if your email address is
    test_account@grandecom.net, you would enter test_account as your Account ID.
    In the Password field, enter in your Grande assigned password. If you do not wish to
    enter your password every time you check your email, put a check in the box labeled
    Save password in my Mac OS keychain. Click the right arrow to continue.
10. On the last screen, enter in an account name in the space provided. This can be
     anything at all, however, Grande suggests that you use something descriptive such
     as Grande E-Mail so you will be able to easily identify this account should you need
     to make changes in the future. Click Finish to begin using Entourage.

Setup OS X Panther Mail
To set up OS X Panther Mail:
1. Click the Mail icon in the Dock (Menu) bar.
2. Select Preferences from the Mail menu.
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3. After clicking the Mail icon, the Mail Setup screen automatically appears. To
    configure your e-mail settings:
    Your Name: Enter your name in the Full Name field
    Email Address: Enter your username plus @grandecom.net in the Email Address field
    Incoming Mail Server: Enter mail.grandecom.net in the Incoming Mail Server field
    Account Type: Select POP from the Account Type drop-down list
    User Name: Enter your Grande user name in the User Name field
    Password: Enter your Grande password in the Password field
    Outgoing Mail Server (SMTP): Enter mail.grandecom.net in the Outgoing Mail
    Server (SMTP) field
4. Click the “OK” button.
5. Your Inbox will be displayed. Click the Get Mail icon to check for new e-mail.

E-Mail “Phishing”
Phishing is the term used by Internet scammers who imitate legitimate companies in e-mails to 
entice people to share user names, passwords, account information or credit card numbers. 
The term Phishing comes from the fact that Internet scammers are using increasingly
sophisticated lures as they “fish” for users’ private information. The most common ploy is to 
copy the look and feel of a web page from a major site and use that design to set up a nearly 
identical page that appears to be part of the company’s site.

There are several steps you can take to make sure you never fall for one of these scams:
• Always be suspicious of any email or phone call that asks for your personal account
   information, such as usernames, passwords, and account numbers. Emails, phone calls,
   text messages, instant messages, or Web logs that appear to come from a reliable
   source may not always be authentic.
• Grande will NEVER ask you for password information via phone or email, as that
   information is private and is only known by you.
• Grande will NEVER ask for billing or payment information through email.
• Always be extra cautious when giving out your personal information on the phone.
• Always ensure that you’re using a secure server when submitting credit card information. 
   To make sure you’re using a secure server, check the beginning of the web address in
   your browsers address bar - it should be https:// rather than just http://.
• Contact your bank or credit card company if you think you may have replied to a
   fraudulent email with sensitive personal information.
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Corporate website	 http://www.grandecom.com

Web Portal	 	 http://www.grandecom.net

Webmail		  http://webmail.grandecom.net

Secure Webmail		 https://webmail.grandecom.net

Email Administration	 https://admin.grandecom.net

Speed Test		  http://speedtest.grandecom.net

Online Support	 	 http://grandecom.net/support
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